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FACTORS & TEST METHODS
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Shipping Codes
& Weights

Shipping codes and weights for shipping are
included in this catalog for your convenience.
The shipping code will refer to one of the
following in this chart. Weight will be in
pounds and enclosed in [ ].

Shipping Code  Description

NH Non Hazardous, No Fees
HF Hazardous Materials,
Air & Ground Fees
R1 Small Quantitz Hazardous
Materials, No Fees
R2,R3,and LQ Hazardous Materials,
Air Fees Only

Test Methods

TITRIMETRIC

DIRECT READING TITRATORS are
1.0mL microburets calibrated for
direct readout in concentration;
no counting of drops

or calculations.

VISUAL COLORIMETRIC

Octa-Slide 2 and LRC
Comparators feature
eight colar standards
with built-in filters
that eliminate
optical distortion.

SHOWLTZ

ELECTRONIC METER/PROBE

Electronic methods generally use a special

electrode for measuring a specific test factor.

An electrode is immersed into a

sample and an amplified current

or voltage is produced and
translated into a digital

. readout. In a colorimeter,

- light is passed through a

sample and measured

by a photodetectar.

FACTORS

Proper control of water quality is an essential part of any successful aguaculture operation.
Immediate test results provided by on-site water analysis equipment can confirm a healthy
environment or give early warning signals for required treatment.

ALKALINITY

Composed primarily of carbonate (C032-)
and bicarbonate (HCO3_), alkalinity acts
as a stabilizer for pH. Alkalinity, pH, and
hardness affect the toxicity of many
substances in the water. Alkalinity is often
referred to as carbonate hardness in the
aquarium industry.

AMMONIA

Ammonia, present in both ionized (NHy4*)
and un-ionized [NH3] forms, is extremely
toxic to fish in the un-ionized form. Even
low levels of un-ionized ammaonia may
affect the fish’s central nervous system,
reducing its ahility to obtain oxygen and
lowering its resistance to disease. A product
of organic waste, ammonia enters the
water directly from the fish, other organic
material, and uneaten food. Ammania
levels are pH dependent and can fluctuate
throughout the day.

CARBON DIOXIDE

Different species of fish have different
susceptihilities to carbon dioxide toxicity.
In some species, excess carbon dioxide
hinders the ability of the blood to hold
oxygen. Produced during respiration and
consumed during photosynthesis, carbon
dioxide levels fluctuate throughout the day
opposite to dissolved oxygen levels. High
carbaon dioxide levels lower the pH, which
in turn affects the ratio of un-ionized to
ionized ammania.

CHLORIDE

Chloride levels can affect fish health in two
ways: as the major constituent of salinity
or as a treatment to prevent nitrite toxicity.
In systems with existing or chranic high
nitrite levels, chloride will often be added to
prevent the fish from succumbing to nitrite
toxicity.

COPPER

Copper, in the form of copper sulfate, is
often used in aquaculture systems as an
algicide and bactericide; however, high
levels can be toxic to fish. High pH and
alkalinity levels will complex copper, helping
to reduce its toxicity.

DISSOLVED OXYGEN

The Dissolved Oxygen test is one of the
most important in agquaculture. Dissolved
oxygen levels can affect fish respiration, as
well as ammonia and nitrite toxicity. Salinity
and temperature are both factors that
affect dissolved oxygen levels.

HARDNESS

Total hardness is defined as the
concentration of calcium [Cap*) and
magnesium (Mgo*] in the water. Closely
related to alkalinity and pH, sufficient
hardness levels can decrease ammonia and
pH toxicity. Calcium is also necessary for
proper egg and fry development.

NITRATE

Nitrate is a product of the nitrogen cycle.
Ammaoania is converted hy bacteria to nitrite,
which in turn is converted to nitrate, also
by bacteria. Nitrates can build up in closed
systems and are often diluted by water
changes. Nitrates from fertilizer runoff in
ponds and lakes can cause algae blooms
that are harmful to aquatic life.

NITRITE

An intermediate product between ammaonia
and nitrate in the nitrification process,
nitrite [NO5-) is extremely toxic to fish.

High levels, comhined with low chloride

and dissolved oxygen concentrations, may
result in methemoglobinemia, better known
as brown blood disease.

pH

pH is a measure of acidity/basicity. The

pH scale is logarithmic and runs from 0 to
14; 7.0 is considered neutral, with values
greater being basic and those lower being
acidic. The greatest concern with pH is how
it affects the toxicity of other substances,
including nitrite and ammonia.

PHOSPHATE (PHOSPHORUS]

Phosphates enter the water supply from
many sources, including agricultural runoff
and sewage. Phosphorus is an essential
nutrient for bone formation and is a primary
ingredient in fertilizers, yet excessive levels
can promote an overabundance of algae.

TEMPERATURE

Water temperature controls the rate of

all chemical reactions and affects fish
growth, reproduction, and immunity. Drastic
temperature changes can be fatal to fish.

LaMotte Aquaculture & Aquarium Testing Products



INDIVIDUAL TEST KITS

&4 e #of #of ShipCode
Test Factor Code Water Method Range/Sensitivity Tests Rgts. [(wt./lbs]  Refill Code
Alkalinity* 4491-DR-01*1 Fresh or Salt  Direct Reading Titrator 0-200 ppm as CaC03 50 2 NH (1] R-4491-DR
for Total (T) Alkalinity in 4.0 ppm increments
Ammonia 3304-02 Fresh or Salt Octa-Slide 2, 0.0,0.050.1,0250.5,1.0, 15, 50 S R2 (1] R-3304
Nitrogen Salicylate Method 2.0 ppm NH3-N
Carbon Dioxidex 7297-DR-0118B Fresh or Salt  Direct Reading Titrator 0-50 ppm CO2 in 1.0 ppm increments 50 2 R1 (1) R-7297-DR
Chloridex 4503-DR-027B Fresh Direct Reading Titrator 0-200 ppm Cl in 4.0 ppm increments 50 4 R1 (1) R-4503-
DR-01
Chlorine 3312-01 Fresh Octa-Slide 2 0.1,020304,0506,08,1.0,ppmCl, S0 2 NH(1)  6999A-H&
for Free & Total Chlorine 6905A-H
Copper 6616-01B Fresh or Salt LRC Comparator 0.0,0.05,0.1,0.15,0.2,0.3, 0.4, 50 1 NH (1] 6446-E
for Total Copper 0.5 ppm Cu
Dissolved 5860-01t Fresh or Salt  Direct Reading Titrator 0-10 ppm Oz in 0.2 ppm increments 50 5 R1 (2] R-5860
Oxygenx All liquid system!
Hardnessx 4824-DR-LT-01 Fresh or Salt  Direct Reading Titrator 0-200 ppm as CaC0g 50 3 R1 (1) R-4824-
for Total, Calcium, & in 4.0 ppm increments DR-LT
Magnesium Hardness
4482-DR-LI-01tR  Fresh or Salt  Direct Reading Titrator 0-200 ppm as CaC03 50 3 R1 (1) R-4482-
for Total Hardness in 4.0 ppm increments DR-LI
3609-01 Fresh or Salt  Direct Reading Titrator 0-200 ppm or 0-2,500 ppm 50 g R1 (1) R-3609
for Calcium Hardness
Iron 4447-01 Freshor Salt  Octa-Slide 2 for Total Iron 0.5, 1.0,2.0,3.0,4.0,6.0,80,100ppmFe 90 2 R1 (1] R-4447
7787-01C Fresh or Salt  LRC Comparator 0.05,01,0203,04,06,08 1.0ppmFe 30 2 R1 (1] R-7787
for Total Iron
Nitrate Nitrogen =~ 3354-01 Fresh or Salt  Octa-Slide 2 0,1,24,6,8,10,15 ppm NO3-N 40 2 NH (2] R-3354
All tablet system!
3110-01B Fresh or Salt  Octa-Slide 2 0.25,0.5,1.0,2.0,4.0,6.0, 80, 50 2 R1 (2] R-3110
10.0 ppm NO3-N
Nitrite Nitrogen ~ 3352-017 Freshor Salt  Octa-Slide 2 0.05,01,02,0.3,04,0.5,08, 50 3 NH (2] R-3352
0.8 ppm NO>~N
Ozone 3248 Fresh or Salt  Digital colarimeter, 0-0.4 ppm 03/0.04 detection limit 100 8 NH (7] =
Indigo Blue method
pH 3353-01tR Freshor Salt  Octa-Slide 2 5.0,6.0,6.5,70,75,80,9.0,10.0 pH 50 1 R1(1] 2218-G
2159-02 Salt LRC Comparator 77,78,78,80,81,8.2 83,84 pH 100 1 R1 (1] 2212-G
Phosphate 3121-02 Fresh or Salt LRC Comparator 0.0,0.2,04,06,08,1.0,1520ppmP04y 50 2 R1(1] R-3121-01
Salinityx 7459-028 Salt Direct Reading Titrator 0-20 ppt Salinity in 0.4 ppt increments 50 2 R1(1] R-7453-01
Sulfide 4456-01 Freshor Salt LRC Comparator 0.2,05,10,20,50,100,15.0, 50 3 R1(1] R-4456
for Total Sulfide 20.0 ppm S=
* Often referred to as Carbonate Hardness in the aquarium industry. + Featured test in AQ Series of combination outfits.
x Note: Direct Reading Titrators have a specific range, but may be refilled to test higher concentrations.
Prop 65: C: & WARNING Cancer - www.P65Warnings.ca.gov/product; R: & WARNING Reproductive Harm - www.P65Warnings.ca.gov/product; [ _ ~
B: A WARNING Cancer and Reproductive Harm - www.P65Warnings.ca.gov/product S
ELaMotte
InstaTest ANALYTIC
N EW I n Sta —Te St® Phosphate Test Strips

Analytic Test Strips

Strip Range Code

for Natural Waters 5-Way Nitrate 0, 20, 40, 80, 160, 200 ppm  3038-G s

_ i
Ideal for routine monitoring of TS L S0 S, U T H %
lakes, streams, ponds, aquaria, and pHB6.0,6.5,70,75,80,8590 i
ornamental fish ponds. Strips may be Alkalinity 0, 40, 80, 120, 180 ppm I
immersed directly into body of yvater Hardness 0, 30, 60, 120, 180 ppm {;
or tank. No test tubes or sampling )
containers required. Suitable for fresh or ~ Ammonia  0,0.5,1.0,3.0,6.0 ppm S
salt water analysis. 25 strips per vial. Phosphate 0, 100, 200, 300, 500, 1000, 2500 ppb ~ 3021-G-ENV
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Aguaponics Test Kit : Fresh . Brackish . Salt Water

Order Code 3637* - Ship Code LQ [9] | Reagent Refill Package Order Code R-3637* - Ship Code LQ (4]

Aquaponics is growing rapidly as a hohby and as an industry as the farm-to-table trend continues to spread. Designed for small ta mid-size systems,
this test kit monitars basic water quality for both the aquaculture and hydroponics segments of your system. A detailed, diagrammed instruction manual
is provided along with a quick reference lid instruction. Reagents, labware, and accessories are mounted in a foam-lined carrying case. Kit is complete
with labware, accessaries, and reagents to perform approximately S0 repetitions per test factor. Test chemistries and comparatars are compatible with
fresh, brackish or salt water systems.

Octa-Slide 2
Comparator Method Range/Sensitivity
Ammonia Salicylate Method 0.0, 0.05, 0.1, 0.25, 0.5,
10,15, 2.0 ppm NH3"N
Nitrite Diazotization/ 0.05,0.1,0.2 03,04,
Coupling 0.5, 0.6, 0.8 ppm NO2>"N
Nitrate Zinc Reduction 0.25,05,1.0,20,4.0,
6.0, 8.0,10.0 ppm NO3-N
pH Wide Range 5.0,6.0,6.5,70,.75,80,
Indicator 9.0,10.0 pH
Iron, Ferrous &  Bipyridyl Indicator ~ 0.5,1.0, 2.0, 3.0, 4.0, 6.0,
Ferric 8.0, 10.0 ppm Fe
x\} Direct Reading
= Titrator Method Range/Sensitivity
= u Alkalinity Acid/Base Titration ~ 0-200 ppm as CaCO0s, in
o g 4.0 ppm increments
-.u Dissolved Madified Winkler 0-10 ppm, in 0.2 ppm

Oxygen Titration

* Prop 65: & WARNING Cancer and Reproductive Harm - www.

Code 3637 PB5Warnings.ca.gov/product

Hydroponics Test Kit

Order Code Code 3561-01* - Shipping Code HF (7] | Reagent Refill Package Order Code R-3561* - Shipping Code HF (3]

Maintain proper nutrient balances and acheive optimum growing conditions in soil-less cultures. Kit comes with enough reagents for 50 repititions per
test factor, complete labware and helpful Plant Nutrition Studies handbook.

Octa-Slide 2 Method Range/Sensitivity
S Comparator
s pH Wide Range Indicator 45,50,55,60,6.5,70,75,8.0, pH
Nitrate Nitrogen Cadmium Reduction 0.25,0.5,1.0,2.0,4.0,6.0,8.0,10.0 ppm
Phosphorus Ascorbic Acid 56,9, 12,15, 18, 24, 30 ppm
Potassium Turbidity Reading Tube 5, 8,10, 20, 30, 40, 60 ppm

* Prop 85: A WARNING Cancer and Reproductive Harm - www.P65Warnings.ca.gov/product

~

' Plant Nutrition
Studies

SSEENRRR

Code 3561-01




Model AQ-2 « Fresh Water

Order Code 3633-05* - Shipping Code R3 [16] | Reagent Refill Order Code R-3633-05*

A complete outfit for pond fish culture—ideal for fresh water analysis. Nine critical test factors can be efficiently and accurately determined on-site.
Designed with field analysis as a priority; all reagents, components, and accessories are arranged for convenience. Lid label instructions are convenient
for quick reference, while a booklet provides detailed instructions. Unit is supplied complete with labware, accessories, sampling bottle, and reagents for

50 tests of each factor.

Direct Reading

Titrator Method Range Sensitivity
lavore ! Alkalinity (Total) ~ Acid/Base Titration 0-200 ppm as CaC03 4.0 ppm
. Carbon Dioxide Titration 0-50 ppm CO2 1.0 ppm
Chloride Titration 0-200 ppm Cl 4.0 ppm
Dissolved Oxygen Modified Winkler Titration ~ 0-10 ppm 0o 0.2 ppm

Hardness (Total] ~ Titration 0-200 ppm as CaCOg 4.0 ppm
Fresh Water Octa-Slide 2
Aquaculture Comparator Method Range/Sensitivity
Ammonia Salicylate Method  00.0, 0.05, 0.1, 0.25, 0.5,
Nitrogen 1.0,1.5,2.0 ppm NHg~-
Nitrite Nitrogen ~ Diazatization/ 0.05,0.1,0.2,0.3,04,05,
E Coupling 0.6, 0.8 ppm NG>~-N
E pH Wide Range 5.0,6.0,6.5,70,75,80,
k] Indicator 9.0,10.0 pH
& = aMotte E
E Temperature Range Sensitivity
%o Armored -5°to 45°C 0.5°C

Code 3633-05 Thermometer
* Prop 65: A WARNING Cancer and Reproductive Harm -
www.P65Warnings.ca.gov/product

Model AQ-4 « Salt Water

Order Code 3635-05* - Shipping Code R3 (16) | Reagent Refill Order Code R-3635-04*

This equipment monitors the nine parameters most critical for the salt water aquaculturist. Reagents, labware, and accessories are mounted for
convenient test selection and portability. Lid label instructions are available for quick reference, while a booklet provides detailed instructions. Unit is

complete with labware, accessories, sampling bottles, and reagents for 50 tests of each factar.

Direct Reading
Titrator Method Range Sensitivity

Alkalinity (Total) Acid/Base Titration 0-200 ppm as CaCO3 4.0 ppm

Carhon Dioxide Titration 0-50 ppm CO2 1.0 ppm

Dissolved Oxygen  Modified Winkler 0-10 ppm G2 0.2 ppm
Titration

Salinity Titration 0-20 ppt Salinity 0.4 ppt

Octa-Slide 2

Comparator Method Range/Sensitivity

Ammonia Salicylate Method 0.0,005,01,0.25,05,10,1.5,

Nitrogen 2.0 ppm NH3"N

Nitrate Nitrogen Cadmium Reduction  0.25,0.5,1.0,20, 4.0, 6.0, 8.0,
10.0 ppm NO3=-N

Nitrite Nitrogen Diazotization/ 0.05,0.1,0.2,0.3,04,05,08,
Coupling 0.8 ppm NO2--N
pH Wide Range Indicator 5.0, 6.0, 6.5, 7.0, 7.5, 8.0, 9.0, 10.0 pH
Temperature Range Sensitivity
Code 3635-05
Armored Thermometer -5°t0 45°C 0.5°C

* Prop 65: & WARNING Cancer and Reproductive Harm - www.P65Warnings.ca.gov/product



INSTRUMENTATION

WATERLINK" SPIN TOUCH" FF

A
6-Wavelength Bluetooth 0 L4 . /\
R watertink s SpINToUChFF:

Touchscreen o0’

000000 eeco
T
Qe ST

WaterLink® Spin Touch® FF

Order Code 3587 « Shipping Code NH [11]

The innovative WaterLink® Spin Touch®FF photometer
daes all your water testing for you. Each reagent disk
contains the precise amount of reagent needed to run a
complete series of tests. Just fill ane unique Spin reagent
disk with less than 3 mL of water and all your vital tests
are done automatically—in just 2 minutes!

SRS
i > A
- OS>

P
s e

-

Portable

a®

e )

T Pre-Measured, =4
Sample-Injected, ~ 4
Reagent Disks

0000000000000 ‘
[
bl

Reliable Results
o Virtually Eliminates User-Error

N\ o Pre-Measured Reagents
Up to o Exact Reaction Time and Auto-Blanking
o Meter Calibration Check System

8 testsin
2 minutes!

® B-Wavelength Photometer

Super Fast & Simple
o 2 Minutes for up to 8 Complete Tests Using One Disk

Specifications: S . .
o Fill Disk and Insert > Tap “Start Test” > Read Results

Instrument Type: Centrifugal Fluidics Photometer
6 Wavelengths: 390 nm, 428 nm, 470 nm, 525 nm, 568 nm, 635 nm Data Logglng
Display: Color Capacitive Touchscreen, 3.5”, 320 X 240 pixel resolution * Stores Test Dates, Times, Results, and Location

) . . . o Download via USB to PC
Languages: English, French, Spanish, German, Italian, Portuguese, Dutch, Swedish,

Turish, Chinese Stand-Alone or Cloud-Connection

Batteries: Lithium lon, Rechargeable [Full Charge in 10-12 hours), o Touchscreen Operation

Communication:
Calibration:

Date Storage:

Water Resistance:

Size & Weight: 8.5Lx4.9Wx41Hin;1.74 Ib;
22.6 Lx127Wx11.4Hcm;0.79 kg
Operation: Single On/0ff/Reset Button with Indicator Light, Touchscreen
Firmware Internet updateable (New Test, New Test Calibrations, etc.),
requires a USB connection to a Windows® PC
Printer Optional Bluetooth® Printer (Code 5-0067);
384 dots per line at 8 dots/mm resolution
Certification CE

150 tests per charge
Bluetooth, USB-C

o Connect to WaterLink Solutions via Bluetooth®

Rugged and Portable

o Innovative Water-Resistant Housing

Factory Set, Field Calibration via Internet Connection

Last 250 Test Results with Date, Time, Location

Rubber Co-molded Base, Rubber USB Port Plug, © Internal, Rechargeable Batteries

Gasketed Display & Hinge

Bluetooth® is a registered trademark of Bluetooth® SIG, Inc.

The Complete Lab Includes: Photometer, Instruction Manual, Quick-Start Instructions, 3 Syringes, Meter
Check Disk, Disk Cover, Sample Bottle, USB Cable with AC Adapter, Carrying Case. [Disks sold separately)

LaMotte Aquaculture & Aquarium Testing Products



INSTRUMENTATION

WATERLINK® SPIN TOUCH" FF

Fill the disk

Reagent Disks

Disks come individually packaged in foil pouches in

FF Fresh Water Reagent Disks

Order Code 4351-H : Box of 50

So Simple! So Fast!

Water Type
> Fres! Tapto
Start Test

® Disk Type
> FF104

Insert the disk

Water Type
> Fres| Tap &
Start

© Disk Type
> FF104

Results
in 2 Minutes

Tap “Start Test”

o Tk
boxed packs of 50. {’i ’,/ »9} . o
'*‘(i "7 WaterLink

& SolutionsPRO

Display Method
Test Parameter ~ Abbreviation Range Accuracy Detection Limit []ptigna| Software
Alkalinity ALK 0-250 ppm +15% 15 ppm e Cloud-based and Free
Ammonia NH3 ~ AMMO 0-3.0 ppm <20ppm: £02ppm 0.2 ppm o Instantly capture date, time, test results, and

> 2.0 ppm: + 0.4 ppm location for each pond or tank
Hardness G HARD 0-500 ppm +15% 20 ppm o View in real time water quality test results of each
Nitrate NO3 NITRATE 0-300 ppm +30% 5 ppm pond or tank
- - © Monitoring Dashboard* provides alerts and
Nitrite NOp NITRITE 0-20ppm +02ppm 01 ppm complete water quality history of each pond or tank
il il =T St Ll o Powerful, customizable treatment engine
Phosphate POy PHOS 0-2.0 ppm 0.2 ppm 0.2 ppm ¢ Download free i0S or Android WaterLink® Solutions
. App for your maobile device
FF Salt Water Reagent Disks . . .
o Sign up for your WaterLink Soutions account at
Order Code 4352-H - Box of 50 www.softwarecenter.lamotte.com

Display Method *Monitoring Dashboard at nominal monthly charge
Test Parameter  Abbreviation Range Accuracy Detection Limit
Alkalinity ALK 0-300 ppm +15% 15 ppm
Ammania NHg AMMO 0-3.0 ppm <1.0ppm:+0.2 ppm; 0.2ppm

>1.0 ppm: = 0.4 ppm

Calcium Ca 200-800 ppm +15% NA
Magnesium Mg 500-2200 ppm  *15% NA
Nitrate NOg NITRATE 0-60 ppm +25% 5 ppm
Nitrite NOp NITRITE 0-2.0 ppm +0.2 ppm 0.1 ppm
pH pH 6.5-10.0 pH +0.2 NA
Phosphate POy~ PHOS 0-2.0 ppm +0.2 ppm 0.2 ppm

Spin Touch® FF disks are available for sale in North America only.

Disk Patent No. 8,734,734; FCI Patent No. 8,987,000; TCI Patent No. 8,993,337;
FCI EU Patent No. EP2784503 A1

LaMotte Aquaculture & Aquarium Testing Products




INSTRUMENTATION

SMART3 COLORIMETER & REAGENT SYSTEMS

SMART3 Colorimeter”

Order Code 1910 - Shipping Code NH (4]

The user-friendly waterproof SMART3 Colorimeter is the direct reading
colorimeter for complete on-site water analyses. Over 60 pre-programmed

tests can be run on this compact instrument and each test features @\,o\*““a '.2} “““““
automatic wavelength selection. The entire multi-LED optical system is \ 5‘;&0«“‘3‘

embedded in the light chamber and optimized for LaMotte test reagent
systems. This enables the analyst to select a wavelength and read a reacted
sample. The microprocessar, which selects the wavelength, also allows the
user to load up to 25 tests for analyzing custom reagent systems. Features
seven user-selected languages. Comes with four sample tubes, USB wall/
computer adapter, and instruction manual. See www.lamotte.com for
additional reagent systems.

Specifications:
Light Source: LED/filter setup at 430 nm, 520 nm, 570 nm, 630 nm

Detector: Photodiode
Display: 160 x 100 Backlight LCD, 20 x 4 line graphics display
Range: 0-125%T Optional Accessories
Resolution: 1% FS e Small Field Carrying Case - Order Code 1910-GCS150  NH (7]
Roaureoy: 0% FS o Large Carrying Case - Order Code 1910-GCS440 - NH (9]
CE Mark: Yes o Car Charger + Order Code 5-0132 - NH (1)
o COD Heater Blac, 120V, 12-Tube Capacity -
Sample Cell: 25 mm round cell, 10 mm square cuvette, 16mm COD tubes Order Code 5-0102 - NH [15)
Power: USB computer/wall adapter or lithium ion rechargeable hattery o COD Heater Bloc, 230V, 12-Tube Capacity -
Battery Life: Charge Life: Approx. 380 tests with backlight on to 1000 tests Order Code 5-0102-EX2 - NH [15)
Xv;t;rgzcgg%hghc;t;f.ggss{gnal averaging diabled). Replacement Parts
Datalogging: Up to 500 data points; USB transfer, time and date stamped o USB Cahle : Order Code 1720« NH (1)
Calibration: Factory set-user adjustable © USB Wall Adapter - Order Code 1721 - NH 1]
Keypad: B-button mechanical o COD/UDV Adapter * Order Code 1724+ NH (1]
Size: 7.5x3.5x 2.5 inches
Weight: 15 ounces

SMART3 Colorimeter” Reagent Systems

Ship Code/

Test Factor Test Method (# of reagents] Range ppm # of Tests Order Code Prop 65+
Alkalinity Tablet, Colorimetric (1) 10-250 50 3670-SC NH
Ammonia Nitrogen LR (Fresh & Salt Water) Salicylate (3] 0.05-1.00/0.10-1.00 25 3659-01-SC R2/R
Ammonia Nitrogen HR Nesslerization (2] 0.05-4.00 50 3642-SC R1/R
Chloride Tablet, Argentometric (1) 0.4-30.0 50 3693-SC NH
Chlorine (Free & Total] DPD Tablets (3] 0.03-4.00 100 3643-SC NH
Chlorine Liquid, DPD (3) 0.03-4.00 144 4859 R1
Chlorine Dioxide DPD tablet/Glycine (2] 0.06-8.00 100 3644-SC NH
COD LR with Mercury* Digestion (1) 5-150 mg/L 25 0075-SC R1
COD LR without Mercury* Digestion (1) 5-150 mg/L 25 0072-SC R1
COD SR with Mercury* Digestion (1) 50-1,500 mg/L 25 0076-SC R1

* Requires COD Heater Block Code 5-0087 (sold separetely)

+ Prop 65: C: A WARNING Cancer - www.P65Warnings.ca.gov/product; R: A WARNING Reproductive Harm - www.P65Warnings.ca.gov/product; B: & WARNING Cancer and

Reproductive Harm - www.P65Warnings.ca.gov/product
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Test Factor

COD SR without Mercury*
COD HR with Mercury*
COD HR without Mercury*
Color

Copper BCA - LR

Copper

Copper DDC

Cyanide

Dissolved Oxygen (DO)
Fluoride

Hardness, Total
Hydrogen Peroxide LR
Hydrogen Peroxide HR
Hydrogen Peroxide Shock
Iron

Iron, Total, Ferrous, Ferric
Lead

Manganese LR
Manganese HR

Nitrate Nitrogen LR
Nitrate

Nitrite Nitrogen LR
Nitrogen, Total*

Ozone LR

Ozone HR

pH CPR

pH PR

pH TB

pH

Phosphate LR
Phosphorus, Total - LR*
Phosphorus, Total - HR*
Potassium

Silica LR

Silica HR

Sulfide LR

Tannin

Turbidity

Test Method (# of reagents]
Digestion (1]

Digestion (1)

Digestion (1]

Platinum Cobalt (0]
Bicinchoninic Acid (1)
Cuprizone (2]
Diethyldithiocarbamate (1)
Pyridine-Barhituric Acid (5)
Winkler Colorimetric (3]
SPADNS (2]

Tablet, Colorimetric (1)

DPD (2)

DPD (2)

DPD (2)

Bipyridyl (2]

1,10 Phenanthraoline (2]
PAR (5)

PAN (3]

Periodate (2]

Cadmium Reduction (2]
Tablet, Zinc Reduction (1]
Diazotization (2)
Chromotropic Acid/ Digestion (6)
Indigo Trisulfonate (3]
Indigo Trisulfonate (3]
Chlorophenyl Red (1)
Liquid, Phenol Red (1)
Thymol Blue (1)

Tablet, Phenol Red (1)
Ascorhic Acid Reduction [2]
Ascaorbic Acid/Digestion (5]
Molybdovanadate/ Digestion (5)
Tetraphenylboron (2]
Heteropoly Blue (4)
Silicomolyhdate (3]
Methylene Blue (3]

Tungsto-Molybdophospharic Acid (2)

Absorptimetric (0]

* Requires COD Heater Block & COD Adapter Code 5-0087 (sold separetely]
+ Prop 65: C: A WARNING Cancer - www.P65Warnings.ca.gov/product; R: A WARNING Reproductive Harm - www.P65Warnings.ca.gov/product; B: & WARNING Cancer and
Reproductive Harm - www.P65Warnings.ca.gov/product
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Range ppm
50-1,500 mg/L
500-15,000 mg/L
500-15,000 mg/L
20-1,000 Cu
0.04-3.50
0.03-2.00
0.10-6.00
0.03-0.35
0.6-11.0
0.1-20
10-400
0.02-1.50
1-60

10-225
0.10-6.00
0.1-5.0

0.1-50
0.01-0.70
0.3-15.0
0.10-3.00
5-60
0.02-0.80
3-25mg/L
0.01-0.40
0.05-2.50

pH 5.0-6.8

pH 6.6-8.4

pH 8.0-8.5

pH 6.6-8.4
0.05-3.00
0.50-3.50 mg/L
5-100mg/L
0.8-10.0
0.05-4.00
1-75
0.06-1.50
0.1-100
3-400 FTU

INSTRUMENTATION

# of Tests

25

100
50
200
50
50
100
100
100
50
50
50
50
50
20
50
20
25
100
20
100
100
100
50
50

25
100
100

50

50

50

Order Code
0073-SC
0077-SC
0074-SC
NA
3640-SC
4023
3646-SC
3660-01-SC
3688-SC
3647-02-SC
3671-SC
3662-SC
4045-01
4045-01
3648-SC
3668-SC
4031-01
3658-01-SC
3669-SC
3649-01-SC
3689-SC
3650-SC
4026-02
3651-SC
3651-SC
3700-01-SC
3700-01-SC
3700-01-SC
3672-SC
3653-SC
4024-01
4025-01
3639-SC
3664-SC
3687-SC
3654-02-SC
3666-01-SC
NA

SMART3 COLORIMETER REAGENT SYSTEMS

Ship Code/
Prop 65t

R1
R1
R1/R
NH
NH
R1
NH/B
R1
R1
R1
NH
NH
NH
R2
R1
R1
R1/C
HF/R
R1
R1/B
NH
NH
R1
NH
NH
NH
NH
NH
NH
R2/C
R1
R1
R1
R1
R1
R1
R1
NH



INSTRUMENTATION

Dissolved Oxygen (DOJ TRACER

Dissolved Oxygen Tracer, Order Code 1761 - Shipping Code NH (1]
DO Sensor Module, Order Code 1762 « Shipping Code NH (1]

© Oxygen level displayed as % Saturation from 0 to 200.0% or Concentration from O to 20.00 ppm (mg/L)
Adjustable Altitude Compensation [0-20,000 ft. in 1,000 ft. increments)
Adjustable Salinity Compensation from O to 50 ppt

TRACER

ni

© Memory stores up to 25 data sets with DO and Temperature reading

»
b
°

Self-calibration on power up; Data Hold, Auto power off, Low battery indicator
Optional 3 ft (1m] or 16 ft. (Sm] extension cable

Complete with DO electrode, protective sensor cap, spare membrane cap, electrolyte, four 1.5V SRA4W hatteries, and 48"
(1.2m) neckstrap

MODE

Description Range Resolution Accuracy
o DO (sat. mode) 0to 200.0% 01% 2% FS

DO (conc. mode) 0 to 20.00 ppm (mg/L] 0.01 ppm (mg/L) 0.4 ppm (mg/L)
Temperature 32 to 122°F (0 to 50°C) 0.1°F/°C +1.8°F (1°C)
Dimensions 1.4x6.9x1.6"(36x176 x 41mm)

Dissolved
xygen

Optional Accessories

Description Order Code Ship Code
DO Membrane Kit (6 screw-on membranes and solution] 1761M NH (1)
Weighted Stand w/Sample Cups (5] 1748 NH (1)
Sample Cups w/caps (24] 1745 NH (1)
DO Extension Cahle (1 meter) 1763 NH (1)
DO Extension Cable (5 meters] 1764 NH(1]

pH TRACER

Order Code 1741 - Shipping Code NH (1)

® Read pH from 0.00-14.00 pH to 0.01 pH resolution
o Supplied with 4, 7, 10 pH buffer tablets

o Automatic self calibration to 1, 2, or 3 points

o Extra bold display includes analog bar graph feature
e Memory can store up to 15 readings

o Chlarine and pH modes also display sample temperature N . 25 '

o Unit identifies which probe is in use and retains calibrations 9 PockeTester

o Automatic shut-off and Low Battery indicator; uses four _ : o
LR-44 hatteries O

o Optional total chlorine probe makes unit a true ISE. g 5 cAL

TCl tablets required
Optional Accessories

ON
OFF

Description Order Code I L dotie
pH Probe; Range: 0-14.00/+0.01 pH 1733

ORP probe; Range: £399mV/+4mV 1734

Cl2 probe; Range: 0-10.00/+10% of reading 1732

Optional weighted stand & 5 sample cups 1746

TCl tablets, 100 pack 7044A-J

Sample cups, 24 pack 1745

10 LaMotte Aquaculture & Aquarium Testing Products



INSTRUMENTATION

SAL/EC/TDS Tracer

Order Code 1749 - Shipping Code NH 1]

This Tracer PockeTester™ offers direct reading of
Conductivity, Total Dissolved Solids, and Salinity with
one electrode. Simply press the MODE key to select

pH/TDS/SALT Tracer

Order Code 1766 - Shipping Code NH 1]

This Tracer PockeTester™ offers direct reading of pH,
Conductivity, Total Dissolved Solids, and Salinity with
one electrode.

any factor.
Model EC/TDS/Salinity Tracer pH/TDS/SALT Tracer
Range | Resolution | Accuracy Range | Resolution Accuracy
Order Code 1748 1766
Conductivity 0t0199.9 S, 0.1 pS/ecm, 0t0198.9 S,
200 to 1999 pS, 1pS/em, 2% 200 to 1999 pS, 0.1pS 1%
2.00t019.99 mS 0.01 mS/cm 2.00t019.99 mS
T0S 0t099.9 ppm [mg/L), | 0.1 ppm (mg/L], 0to 99.9 ppm [mg/L),
100 to 999 ppm (mg/L), | 1 ppm (mag/L), +2% 100 to 999 ppm (mg/L), | 0.1 ppm [mg/L) +2%
1.00 to 9.99 ppt (g/L) 0.01 ppt (g/L) 1.00 to 9.99 ppt
Salinity 0 to 99.9 ppm, 0.1 ppm, 0t0 99.9 ppm [mg/L], a
100 to 999 ppm, 1 ppm, +2% 100 to 999 ppm (mg/L), | 0.1 ppm (mag/L) 2% 3
1.00 to 9.99 ppt 0.01 ppt 1.00 to 9.99 ppt o
pH — - — 0.00 to 14.11 pH 0.04 pH +0.01 pH Dy
Temperature +1°C (1.8°F) 32° to 149°F (0 to 65°C) 0.1°F/°C +1.8°F/°C
Power Four 3V CR-2032 Batteries Four 3V CR-2032 Batteries
Special Features Auto Shutoff after 10 minutes, Low BAT indicatar, Auto Shutoff after 10 minutes, Low BAT indicator,
Digital and Analog Display, Hold 15 tagged readings Digital and Analog Display, Hold 25 tagged readings
Special Functions Calibration Function, ATC Self Calibration
Replacement
Electrode Lofe L7
2 O 20 | PU rta b I e Mode Nephelometric Ratiometric Attenuation
HH Unit of Measure NTU, FNRU, ASBC, EBC NTU, FNU, ASBC, EBC NTU, FAU, ASBC, EBC
Turbidity Meter
L Range 0-100 NTU/FNU; 0-1,000 NTRU/FNRU; 0-2,000 AU/FAU;
Order Code 1974-1 - Shipping Code NH (6] 0-1,750 ASBC; 0-17,500 ASBC; 0-70,000 ASBC;
New RATIOMETRIC design in one of the maost 0-25EBC 0-250 EBC 0-1.000 EBC
innovative, WATERPROOF, handheld meters Resolution 0-10.99 NTU/FNU:0.01;  0-10.99 NTRU/FNRU:0.01;  0-2000 AU/FAU: 1
available on the market! Perfect for field and 11.0-100.0 NTU/FNU: 0.1 11.0-108.9 NTRU/FNRU: 0.1;
laboratory applications, this compact and easy-to- 110-1000 NTRU/FNRU: 1
use instrument is an exceptional value. Includes Accuracy 0-2.5 NTU/FNU: 0.05; 0-2.5 NTRU/FNRU: 0.05; 0-2000 AU/FAU:

standards, tubes and carrying case.

Features

* Advanced calibration
algorithms

* Easy menu driven
operation and
large LCD display

* 500 point
data log

D) ) €
EXT) @

D)

Detection Limit
Reproducibility
Range Selection
Light Source
Detector

Signal Averaging
Power

Data Logging
Auto Shut-0ff
Languages
Response Time
Display

Size

Weight

2.5-100 NTU/FNU: 2% 2.5-100 NTRU/FNRU: =2%;

100-1000 NTRU/FNRU: #3%
0.05 NTU/FNU 0.05 NTRU/FNRU
0.02 NTU/FNU or 1% 0.02 NTRU/FNRU or 1%
Automatic

IR LED 860 nm =10 nm, spectral bandwidth with 50 nm
Photodiode, centered at 90° and 180°

Disabled, 2, 5, 10

+10 AU/FAU or 6%,
whichever is greater

10 AU/FAU
1%

USB computer cable, wall adapter or Lithium ion rechargeable battery

500 points
Disabled, 5, 10, 30 seconds

English, French, Spanish, Japanese, Italian, Portuguese, Chinese

<2 Seconds
6-line LCD with backlit display
75x3.5x 25 inches; 19.05 x 8.84 x 6.35 cm

13 ounces

LaMotte Aquaculture & Aquarium Testing Products
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SAMPLING EQUIPMENT

Visit our website www.lamotte.com for our complete selection of water sampling equipment.

Bottom
Sampling
Dredge

Order Code 1097
Shipping Code NH (5)

Stainless steel sampler
designed for use on soft
bottoms [sand or silt). A simple
trigger holds the sampler open
while lowering to caver uniform
area. Scissor design closes
sampler, retrieving a volume of
sediment to the surface.

Code 1087

Horizontal Water Sampler

Order Code 1087 - Shipping Code NH 5]

Collect water samples quickly and easily! This newly designed horizontal
water sampler allows water to be sampled at specific depths. A 20 meter
calibrated line, marked at one meter intervals, is included. The clear
polycarbonate tube allows a visual inspection of the sample prior to
dispensing and holds approximately 1,200 mL of sample. Send the weighted
messenger down the line to trip the closing mechanism at the desired depth.
Open one chamber end cap to dispense sample.

Secchi Disk

Order Code 0171-CL

Armored Thermometer
Model 545 : Order Code 1066

Sounding Lead &
Calibrated Line

Shipping Code NH [?] ShIPP'""'EI Code NH (1] o Order Code 1064-G
Order Code 0171 [Dlsk Only] A precision thermometer furnished in a Shinning Code NH [q]
Shipping Code NH (3) protective plastic jacket with window opening. PpIng

To determine water turbidity in the aquatic
environment. A weighted hlack and white
quadrant plastic disk (20 cm diameter] is
lowered into the water until it disappears.
Calibrated line is marked every half meter up to
20 meters. Braided line.

Engraved graduations on white tubing center
increases readahility which covers the range of
-5°to 45°C in 0.5° increments.

This heavy nylon line is marked from 0-20
meters and has a spring clip for easy
attachment to a Secchi Disk, plankton net or

a lead weight. A 2 Ib. (0.9Kg] lead weight is
provided. The nylon line wraps conveniently
around an ethafoam block which also acts as a
float to prevent accidental loss.
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